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Introduction

Use the Above & Beyond Notebook to store addresses, phone numbers, project notes, or any 
information that you want to keep handy.    The pages are alphabetized by page title.    You can 
add pages and create new notebooks as needed.    You can even merge Notebooks.    It's an 
efficient system for organizing your data and keeping it organized.    



Starting the Notebook

The Notebook can be started from the Worktools menu in Above & Beyond.    You may list 
several Notebooks in the Worktools menu.    For information on how to do this, see The 
Worktools Menu in the Menu Reference Section of Above & Beyond Help.

The Notebook can also be started from an icon in the Windows Program Manager.    You may 
set up an icon for each of your Notebooks.    For example, if you have saved a notebook (in your
"ab" directory) as "phone.nbk", then the icon command line would be as follows:

C:\ab\nb.exe    C:\ab\phone.nbk



Getting Started

Below the menu bar is an area labeled "Notebook Page Titles."    The titles for each page of the 
Notebook are displayed alphabetically in this area.    When you select a page title in the upper 
window --for example, by clicking on it-- the contents of the page is displayed in lower window.

To scroll through the page titles use PAGE UP and PAGE DOWN, or click on the up or down 
scroll arrow to the right of the page titles.    If the focus is in the page titles area, you can move 
quickly to the page titles that begin with a particular character by pressing the first character of 
the desired page title.    Note: Click on any page title to place the focus there.

As with any other window you may move or size the Notebook window to your liking.    To resize,
use the mouse to drag the edges of the window.    To move, point at "Above & Beyond 
Notebook" and drag to a new location.    Without a mouse, you may access moving and sizing 
commands in the control menu by pressing ALT+SPACEBAR.    For example, to display the 
notebook full screen, press ALT+SPACEBAR then press X for Maximize.



The File Menu

The commands in the File menu will allow you to create a new notebook, open an existing 
notebook, print notebook pages or entire notebooks, save the changes you have made to 
notebook contents, change a notebook's title and merge notebooks.    You may also 
import/export text files; and import/export Cardfiles from/to the Windows Cardfile application.

New
Open
Save
Save As
Print One
Print All
Merge
Import
Export
Exit
About Notebook



File: Import

Comma Separated Values (CSV)
Cardfile
Text File
ASCII Database



File: Export

Comma Separated Values (CSV)
Cardfile
Formatted Text File
Unformatted Text File



File: New

Selecting the New command brings up an blank untitled notebook.    The cursor is in position so 
you may begin typing immediately on the first page.    When finished entering data onto the 
page, give the page a title using Edit: Title.    To add a new page to your notebook, use Edit: 
Insert Page. 
 
When you have finished with your new notebook, select File:Save to give the notebook a title.



File: Open

The Open command allows you to work with an existing notebook file.    You can select a 
notebook from the list,    or type the name of the notebook in the text box titled "Open File 
Name:".



File: Save

The Save command saves to disk the changes you have made to your notebook.



File: Save As

Use this command to change the title of your notebook, while saving the changes you have 
made.



File: Print One

The Print One command will print the currently selected notebook page.    The font used will be 
the font you have selected in the Above & Beyond File menu    (File: Choose Fonts: Printer: 
Normal Text).



File: Print All

The Print All command will print out the entire notebook.    The font used will be the font you 
have selected in the Above & Beyond File menu    (File: Choose Fonts: Printer: Normal Text).



File: Merge

The merge command enables you to combine two notebooks. Type (or select) the name of the 
notebook you wish to combine with the current notebook.



File: Import: Comma Separated Values (CSV)

Use this command to import CSV data into a notebook.    Type in name of a file containing data 
in CSV format.    Select "Merge" and the data will be imported and merged with the current 
notebook.



File: Import Cardfile

Use this command to merge a cardfile (from the Windows application named Cardfile) with a 
notebook.    Type (or select) the name of the cardfile you wish to import.    Click on "Merge" and 
the data from the cardfile will be imported and merged with the notebook. 



File: Import Text File

Use this command enables to import data from a text file into a notebook.    Type (or select) the 
name of the text file to import and click on "Merge".    New notebook pages will be created to 
accommodate the new data.    The new page titles will be "page 1", "page 2", etc.



File: Import ASCII Database

Use this command to bring the contents of an ASCII database into a Notebook file.    Each line in
the database will become one notebook page.    A tab (or multiple spaces) within a line of    the 
database will start a new line on the notebook page. 

The first line of each notebook page will also appear as the page title.    The notebook pages will
be alphabetized by title.

For example...

Import file:

Smith, John 54 Cedar Blvd Mill Valley, CA 94888
Taylor, Phil 728 Main St. Fairfax, CA 94343

Notebook pages:

Title: Smith, John
Page: Smith, John

54 Cedar Blvd
Mill Valley, CA 94888

Title: Taylor, Phill
Page: Taylor, Phill

728 Main St.
Fairfax, CA 94343



File: Export: Comma Separated Values (CSV)

Use this command to export notebook data in CSV format to a file called Export.Txt.



File: Export Cardfile

Use this command to export data from a notebook to a file readable by the Windows Cardfile.    
Type in a (.CRD) filename or select a cardfile from the list of existing cardfiles.    The capacity of 
the Windows Cardfile is more limited than the Notebook. For example pages are limited to 440 
characters each.    In cases where notes exceed the capacity of the Cardfile they are truncated.



File: Export Formatted Text File

Use this command to copy the contents of a notebook to a text file.    Lines are formatted so that
they extend no more than 72 characters each.    Formatted export is preferable to unformatted 
when you're going to be viewing the export file in another application that does not have word-
wrap.



File: Export Unformatted Text File

Use this command to copy the contents of a notebook to a text file.    Lines are not broken 
unless there is an explicit newline in the text.. Unformatted export is preferable to formatted 
when you're going to be viewing the export file in another application that has word-wrap.



File: Exit

The Exit command will close the Notebook window.    If you have not already saved changes to 
your notebook, you will be asked whether or not you would like your changes saved.    Note: You
may select Cancel at his point to return you to your Notebook session. 



File: About Notebook

The About Notebook command will display the total number of notebook pages in the notebook. 
The application title and version number is also displayed. 



The Edit Menu

The commands in the notebook Edit menu will allow you to delete and rename notebook pages,
view specific notebook pages, and to delete, copy and move information on the notebook 
pages. 

Insert Page
Edit Title
Duplicate Page
Prior Page
Next Page
Word Count
Delete
Cut
Copy
Paste
Undo
Text Edit
Graphics Edit



Edit: Insert Page

To add a page to the notebook you are currently working in, press the INSERT key, or select 
Edit: Insert Page.
 
You will be asked to give a title to the notebook page that is about to be added.    Type in the title
and select "OK".    A blank notebook page will appear with the cursor positioned for you to begin 
typing.
 
If the current (selected) page does not have a title, you will be asked to enter a title for this page
before entering the title for the new page about to be added. 



Edit: Title

To edit the title of the selected notebook page, press F6; or select Edit: Title.    You may have 
more than one notebook page with the same title. 



Edit: Duplicate Page

To create a duplicate Notebook page press F2 (or select Edit: Duplicate Page).    The duplicate 
page will have the same title and contents as the original.



Edit: Prior Page

To display the notebook page previous to the page you are currently viewing, press PAGE UP; 
or select Edit: Prior Page. 



Edit: Next Page

To display the notebook page after the page you are currently viewing, press PAGE DOWN; or 
select Edit: Next Page. 



Edit: Word Count

The Word Count command reads the text on the currently displayed notebook page, and counts
the number of whole words and the number of characters on the page.    All characters are 
counted, including numeric characters, punctuation marks and blank spaces.    Number groups, 
such as phone numbers, are counted as a single word. 



Edit: Delete Page

The Delete Page command will remove an entire notebook page from the notebook.



Edit: Cut

The Cut command deletes the selected text from the notebook page.    The deleted text is 
placed in a temporary holding area known as the Windows clipboard.    You can insert it back 
into your notebook page or to another page of the notebook with the Paste command.    A 
shortcut for this command is CTRL+X.
 
Note: There must be some selected text on the notebook page in order for the Cut command to 
be available.



Edit: Copy

The Copy command copies the selected text to the Windows clipboard so that, using the Paste 
command, you may duplicate the text in another area of the notebook page or on a different 
notebook page.    A shortcut for this command is to press CTRL+C.
 
Note: There must be selected text on the notebook page in order for the Copy command to be 
available.



Edit: Paste

The Paste command inserts (to the right of the cursor) text that has been placed on the 
Windows clipboard using Copy or Cut.    A shortcut for Paste is to press CTRL+V. 



Edit: Undo

The Undo command cancels the last editing command performed and restores the notebook 
page to the state prior to that command.    A shortcut for this command is to press 
ALT+BACKSPACE.
 
If text was Cut from the notebook page, it will be returned to the same position with the Undo 
command.    If text was Pasted to a notebook page, the Undo command will remove it.    Using 
the Undo command again will return the Pasted text back to its former position.    While 
employing the Undo command, the selected text will remain on the clipboard. However, only 
one selection can be on the clipboard at any one time.    Each new Cut or Copy operation 
replaces the previous selection stored in the clipboard. 

Example: Moving Text

Select the text you wish to move.    Use CTRL+X (or Edit: Cut) to remove the text from its 
present location and place it on the clipboard.    Next move the cursor to the position on the 
Notebook page where you would like the text inserted.    Press CTRL+V (or Edit: Paste) and the 
selected text will be inserted to the right of the cursor.    If the new position is not correct, use 
ALT+BACKSPACE (or Edit: Undo) to remove the text. 

Example: Copying Text

Select the text that you would like reproduced.    Use CTRL+C (or Edit: Copy) to place a copy of 
the text on the clipboard.    Next move the cursor to the position on the Notebook page where 
you would like to place the copied text.    Press CTRL+V (or Edit: Paste) to insert the text to the 
right of the cursor.



Edit: Text Edit

The Text Edit command will allow you to edit text on a notebook page.    Graphics cannot be 
edited when the Text Edit command has been selected. 



Edit: Graphics Edit

The Graphics Edit command will allow you to edit graphics (e.g. a picture) on a notebook page.  
An example of graphics is an image pasted in from Windows Paint or a scanned image from a 
Windows application such as PC Image.    Text cannot be edited when the Graphics Edit 
command has been selected.    



Search

The Search commands allow you to search for one or more characters, or a sequence of words 
in either the notebook pages or the notebook page titles.

Titles
Notes
Re-search Notes
Re-search Titles



Search: Titles

Use Search Titles to search for a sequence of characters or words among all the page titles of a
notebook.    If the specified sequence is found in a page title, that notebook page will be 
displayed.    



Search: Notes

Use Search Notes to search for a sequence of characters or words in the pages of a notebook.   
If the specified sequence is found on a notebook page, that page will be displayed. 



Search: Re-search Notes

This command will repeat the Search Notes command.    Use this when the first occurrence 
found in a search is not the one you want.    Shortcut: press F3. 



Search: Re-search Titles

This command will repeat the Search Titles command.    Use this when the first occurrence 
found in a search is not the one you want.    Shortcut: press F4.



AutoDial

If the current Notebook page contains a phone number (with hyphens), that number will appear 
when AutoDial is selected.    You may make changes to the number before dialing.
 
If there is no phone number on the currently displayed notebook page, then the text box will be 
blank.    You may type in the phone number to be dialed. 
 
When you have more than one phone number in a notebook page, you can indicate which one 
to dial    by selecting the number before choosing AutoDial.
 
When all the information in the dialog box is correct, push Local, Distance, or International and 
the number will be dialed.

It is recommended that you include area codes in the phone numbers in your phone book. This 
means that if you travel to another area code, your phone book will not have to be edited. 

AutoDial Settings

Fill in your local area code so that it will not be dialed when calling numbers within this area 
code.

If you need to dial 9 for an outside line, specify "9," in Outside Line Prefix.    The comma 
instructs Autodial to wait a few seconds for the outside dial tone before proceeding.

When an outside line prefix is specified, it will be included during the dialing sequence. 

If you press the Local button, the number will be dialed as is (with the only possible addition of 
the outside line prefix). The outside line is also used on Distance and International calls if it is 
filled in. If you press Distance, the long distance prefix will be included. If you press 
International, the international prefix will be included. If there is an area in the displayed number 
to be dialed, it will be omitted if it matches your indicated local area code.

The "Tone" and "Pulse" option buttons enable you to chose the type of dialing to be done.      The
"COM1", "COM2", "COM3", and "COM4" option buttons enable you to select the serial port that 
your modem is set for. 
 


